USER'S MANUAL

for the

RELOCATABLE MODELING ENVIRONMENT (RME)
VERSION 1.0

by
Shuvobroto Brahmachari

Technical Report 5-98
1 September 1998

Prepared for: Office of Naval Research

Contract Numbers: ONR Research Grant N00014-95-1-0203

Approved for public release; distribution is unlimited.
Mississippi State University Center for Air Sea Technology
Stennis Space Center, MS 39529-6000
USER'S MANUAL

For the

RELOCATABLE MODELING ENVIRONMENT
(RME)
VERSION 1.0

by

Shuvobroto Brahmachari

ONR RESEARCH GRANT NO: N00014-95-1-0203

Prepared for

OFFICE OF NAVAL RESEARCH

Prepared by

Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS  39529-6000
ACKNOWLEDGEMENTS

UNIX is a trademark of American Telephone and Telegraph (AT&T), Incorporated

SGI, IRIX and Indigo are trademarks of Silicon Graphics, Incorporated

Motif is a trademark of the Open Software Foundation

X-Window is a trademark of the Massachusetts Institute of Technology

NCAR is a trademark of the University Corporation of Atmospheric Research, Incorporated

Contributors to the RME Software Design Document are:

Mr. Shuvobroto Brahmachari, Project Leader
Mr. Steven W. Payne
Dr. Avichal Mehra
Mr. Clifton Abbot
# TABLE OF CONTENTS

1.0 INTRODUCTION ............................................................................................................. 1  
  1.1 SCOPE .................................................................................................................... 1  
    1.1.1 Identification ................................................................................................. 1  
    1.1.2 Background ................................................................................................. 1  
  1.2 CONVENTIONS ........................................................................................................ 4  
  1.3 REFERENCED DOCUMENTS ..................................................................................... 4  

2.0 EXECUTION PROCEDURES ......................................................................................... 4  
  2.1 INITIALIZATION (LAUNCHING THE APPLICATION) ................................................. 4  
  2.2 DESCRIPTION OF PROCEDURES ......................................................................... 6  
    2.2.1 Grid Generator ............................................................................................. 6  
    2.2.2 Pre-Processor ............................................................................................... 14  
    2.2.3 Model Packaging ......................................................................................... 29  
    2.2.4 Remote Execution ....................................................................................... 31  
    2.2.5 Local Execution ......................................................................................... 34  
    2.2.6 Post-Processor ............................................................................................. 35  

3.0 ERROR MESSAGES .................................................................................................... 42  
  3.1 GRID GENERATOR ................................................................................................ 45  
  3.2 PRE-PROCESSOR .................................................................................................. 46  
  3.3 MODEL PACKAGER .............................................................................................. 48  
  3.4 REMOTE/LOCAL EXECUTION ............................................................................... 48  
  3.5 POST-PROCESSOR ............................................................................................... 48  

4.0 NOTES ......................................................................................................................... 50  
  4.1 SYSTEM CONSIDERATIONS ............................................................................... 50  
  4.2 SYSTEM/SOFTWARE REQUIREMENTS ............................................................... 50  
  4.3 DIRECTORY MAP .................................................................................................. 51  
  4.4 SECURITY ............................................................................................................... 51  

APPENDIX A (GLOSSARY OF TERMS) ............................................................................. 53  

APPENDIX B (ABBREVIATIONS USED) ........................................................................... 56  

APPENDIX C (RME DATABASE CONFIGURATION SYSTEM) ....................................... 58  

APPENDIX D (RME INSTALLATION PROCEDURES) ............................................... 59  

APPENDIX E (RME DIRECTORY STRUCTURE) ............................................................ 61  

APPENDIX F (MODEL PARAMETERS) ............................................................................ 63  

APPENDIX G (JULIAN DATE CALENDAR) ...................................................................... 66
1.0 INTRODUCTION

1.1 Scope

1.1.1 Identification

Version 1.0 (22 February 1998)
ONR Research Grant No: N00014-95-1-0203
Contractor: Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS 39529-6000
Telephone: (228) 688-4218
Facsimile: (228) 688-7100

1.1.2 Background

The many steps and logistics of setting-up a numerical model in a new region
of interest are tedious and labor intensive. Much of this effort can be simplified
with modern computer technology. For example, in setting-up a 2-D tidal model, one
needs to specify the domain, define the model grid of a specified resolution, select
the appropriate bathymetry database and extract the data, edit the bathymetry for
errors such as opening-up closed channels, select and extract ancillary data such as
the International Hydrographic Office (IHO) tidal station data, make sure the stations
fall on a grid point over water instead of land, edit the ancillary data to correct errors,
define the model boundaries, specify the model boundary conditions, generate the
model header files, and generate the model input and initialization files.

All of these steps need to be completed before the model can be run to obtain
the first output. This process can consume anywhere from a couple of days to a
couple of weeks depending on the complexity of the domain and data. For more complex, 3-D, data assimilating circulation models, there are also other steps. The user is also faced with postprocessing the model output and managing it systematically.

Under ONR funding, the University of Colorado has developed the CURRENTSS (Colorado University’s Rapidly Relocatable Nestable Tides and Storm Surge) Model, which is currently a 2-D tidal model. The Mississippi State University Center for Air Sea Technology (MSU-CAST) has embedded the model in a Relocatable Modeling Environment (RME), that provides a user friendly, interactive graphical user interface (GUI) which allows for quick relocation of the model to any oceanic region for which databases and forcing fields exist. This report provides a user’s manual for this system. This system includes the following modules:

**Grid Generation:** The GUI produces a world map for selecting the region to be modeled. The user specifies a uniform grid spacing and two diagonal points on the model domain boundary, and the GUI automatically generates the ‘rectangular’ grid (actually, grid lengths DX = DY are specified in degrees, and only for small domains is the grid approximately rectangular). Similarly, the nested grid is embedded in the coarse domain. The GUI automatically creates four files needed for model initialization:

1. (Longitude, Latitude) for each grid point in the coarse grid
2. (Longitude, Latitude) for each grid point in the fine grid
3. Interpolated bathymetry for the coarse grid
4. Interpolated bathymetry for the fine grid.

In addition, the GUI creates a file of tidal constituents from tide gauge stations located in the model domain, extracted from the IHO database (1979) supplemented with data from the Admiralty charts (1993). Data for each tidal constituent from the selected stations are assimilated into the model.

**Pre-Processing:** This module provides an interactive capability to edit the bathymetry and the IHO station files. The bathymetry editing capability allows one to open or close channels or change depths, according to the information available at the time of model execution. Similarly, editing of the IHO station files provides the capability to de-select stations (for data assimilation), if so required, or to move them spatially (essentially altering their locations).
**Model Packaging:** This module is transparent to the user and his interaction at this stage is not needed. The model packaging module readies data files for porting to a remote host machine. This involves converting files to netCDF followed by tarring of all source code files and data files necessary for successful model execution.

**Remote/Local Execution:** This module offers the user an opportunity to modify any of the input parameters, e.g., bottom roughness, model integration time-step, etc. After entering the URL address of the remote machine, the model package is ported to it. The files are automatically un-tarred, the source code compiled, and submitted to the machine for execution. After the execution is complete, the saved output files are automatically tarred and imported back to the local machine for post-processing, and the user receives the message of run completion on the local machine.

**Post-Processing:** This module provides the capability of preparing graphics from the saved model output. These include time-series plots at selected locations of: vertically integrated currents including U, V, speed, and sea surface height; snapshots of tidal current vectors with overlying contours of sea surface height which can be used for preparing animations of model results; tables for tidal events for a specified duration; and co-tidal and co-phase plots for all tidal constituents.

The objective of the RME is to provide an interactive capability of relocating the CURReNTSS model to any region of the world, run the model at a remote location if so preferred, and visualize the model results in selected formats which can facilitate interpretation of results. The main objective of RME is to provide a user-friendly, interactive GUI for an end-to-end implementation of the model. The implementation is achieved using the Extensible Distributed Graphical Environment (EDGE) concept developed at CAST. This version is tuned to CURReNTSS but can be tailored in the future to any atmospheric/oceanic model. This manual documents procedures of the RME.

The RME provides the user with a default bathymetry database of ETOPO5 but can incorporate any local/regional/global bathymetry database in the longitude-latitude-bathymetry format. It uses the global tidal station database for assimilation. The boundary conditions data sets from the Global Model Run for CURReNTSS and the Desai-Wahr run are also supplied to the user.
1.2 Conventions

To simplify and standardize the communication of procedural details to the user, this manual adopts the following conventions:

**Mouse Button Convention:** ‘Click’ or ‘select’ operations with the mouse are to be done with the left button unless otherwise specified.

**Dragging the Mouse:** ‘Drag’ operations are done by depressing the middle button unless otherwise specified, moving it to the desired spot, and then releasing it.

**Rubber-banding:** This process involves depressing the left mouse button and moving the cursor from the top left corner of the region of interest on a picture/map to the bottom right corner (while keeping it pressed), and then releasing the left mouse button. This procedure forms a rectangular border, which is usually used to specify a region for zooming and other functions.

1.3 Referenced Documents


2.0 EXECUTION PROCEDURES

2.1 Initialization (Launching the Application)

RME observes the standard procedure for executing an application in the UNIX/X-Windows environment. After specifying pathnames and environment variables in the ‘.cshrc’ or ‘.login’ files, the user enters ‘rme2d’ at the UNIX command line prompt.

This starts up the EDGE environment to run the RME modules. When X-Windows initialization procedures are complete, the RME GUI initial window appears (Figure 1). The icons displayed represent the three categories of models that
RME can incorporate in future versions. Double clicking on the ‘Tidal Models’ icon brings up the icons representing tidal models (Figure 2).

![RME initial window](image1)

Figure 1 - RME initial window

![RME Tidal Model window](image2)

Figure 2 – RME Tidal Model window

Since RME currently incorporates only the CURReNTSS model, this is the only icon displayed here. Double clicking on it will bring up a page containing icons representing RME processes and databases (Figure 3). This is the main ‘RME procedures page’ and is the central console for all RME operations.
2.2 Description of Modules

Six procedure modules can be seen in Figure 3, as green icons in the upper row. The two pink icons represent the database managers, which organize data into easily operable visual packets. The processes are described in detail below.

2.2.1 Grid Generator

The steps required to run the Grid Generator module for RME:

1. Double click on the Grid Generator icon to produce the Grid Generator GUI (Figure 4). This has a world map for selecting the region of interest.
Figure 4 – Grid Generator GUI
Figure 5 – Nesting a region in the Grid Generator
2. a. Either rubber-band the region or specify the minimum and maximum latitudes and longitudes in the region coordinates textbox, and hit enter. The permissible range for latitudes is −90 to 90 and that of longitudes is −180 to 180.

b. Alternatively select a region from the ‘Defined Grids’ box which displays previously defined grids stored in the database.

3. A white-bordered region of interest is created and displayed (see Figure 4).

4. Use the ‘zoom’ button to zoom in for final region selection or for nesting a grid (see Figure 5).

5. Using the ‘unzoom’ button returns to the previously selected grid, or to the world map if no grid has been selected before. The ‘Lat’ and ‘Lon’ boxes provided next to the ‘zoom’ and ‘unzoom’ buttons indicate the position of the cursor which is displayed as a cross in the map area.

6. Specify the model grid resolution in the ‘X and Y resolution’ boxes in degrees.

7. Select a bathymetry from the ‘Defined Bathymetries’ box. The ETOPO5 is supplied with RME, and the user can append any regional/global bathymetry of preference to the database provided they are in an acceptable format (see Appendix C).

8. Select an IHO station database for the ‘Defined Stations’ box.

9. Save the region by clicking on ‘Region’ in the overhead pull-down menu and then clicking on ‘save’.

10. This pops up the ‘Add Region Dialog’ window (Figure 6) which has a box for the region name.

11. Enter a name of choice for the region and click on the ‘Add’ button, which will initiate the saving process.
The bathymetry file selected is interpolated and mapped on to the grid and the regional station data is extracted from the global database for future editing in the ‘Pre-Processor’ module. After the saving process is complete, the saved region name appears in ‘Defined Grids’ box. If the user chooses to nest a grid, the following steps must be taken:

1. Click on previously selected region from the ‘Defined Grids’ box.

2. Click on ‘Region’ on the pull-down menu and then click on the ‘Nested’ toggle button.

3. A region of choice can either be rubber-banded, or the coordinates of the nested grid can be entered in the ‘Region Coordinates’ box as before.

4. Instead of filling in the grid resolution, select a ratio to the original grid from the Nested Resolution box.

5. The nested region can be saved in a similar manner to the regular region.

It should be noted that the saving process can take up to several minutes depending on the size and resolution of the grid as extraction and interpolation is carried out during the saving process. The user must wait for the ‘Add Region Dialog’ window to disappear for confirmation of file saving.
2.2.1.1 Menu Bar

The Grid Generator Module contains a menu bar consisting of four pull-down menus. These interactive menu headers are labeled ‘File’, ‘Region’, ‘Overlay’ and ‘Help’.

2.2.1.1.1 File Pull-down Menu

The options available from the ‘File’ pull-down menu are ‘ReDraw’, ‘Iconify’, and ‘Quit’ (Figure 7). There are keyboard shortcuts available for these menu options and these are noted alongside the names.

**ReDraw** - The ‘ReDraw’ option deletes the image in the Map section and draws it again to remove any distortions that may have been caused by other applications.

**Iconify** - The ‘Iconify’ button reduces the Grid Generator GUI to an icon, which can be retrieved by clicking on it.

**Quit** - The ‘Quit’ button stops the ‘Grid Generator’ process. The user must note that all unsaved regions will be lost if this option is used. The GUI does not prompt the user to save if the ‘Quit’ button is pressed. These options are similar to the ones in the other modules as well.

![File Menu](image)

*Figure 7 – The ‘File’ pull-down menu for the Grid Generator*
2.2.1.1.2 Region Pull-down Menu

The options available from the ‘Region’ pull-down menu are ‘Delete’, ‘Nest’, ‘Reset’ and ‘Save’. The ‘Nest’ and the ‘Save’ button functions have already been discussed in the previous section.

Delete - To delete a saved region, the user selects the desired region in the ‘Defined Grids’ box and presses the ‘Delete’ button which removes the selected database.

Nest - The ‘Nest’ button is a toggle button, which can be turned on or off depending on the user’s preference of the type of grid. However, a warning is posted in the ‘Remark’ box if the user tries to save a nested region without defining a regular grid first.

Save - The ‘Save’ button prompts the user to save a particular region that has been selected.

Reset - The ‘Reset’ button, removes all unsaved region selection and redraws the world map.

2.2.1.1.3 Overlay Pull-down Menu

The ‘Overlay’ header in this module provides the user with only the option of overlaying labels on the Map. Clicking on the ‘Labels’ button pops up the ‘Labels and Arrows’ window (Figure 8) which has specifications of the type of label the user might want displayed in the map. The features of the window are listed below:

- The ‘Arrow On/Off’ radio button attaches an arrow to the text for labeling purposes.
- The arrow length, width and head length can be specified by dragging the sliders using the left mouse button.
- The ‘Angle’ box is for specifying the angle of the text to appear in degrees.
- The ‘Label Text’ box can be used by the reader to put in the text for the label.
- The ‘Clear Entries’ button clears the entries made in the ‘Angle’ and ‘Label Text’ boxes.
- A choice of fonts for the label text is provided in the ‘Text Font’ box.
• The label text can also be justified using choices in the ‘Text Justification’ box.
• The text size can be altered by using the ‘Text Size’ slider bar.
• The color can be changed by clicking on the color box.
• The ‘Dismiss’ button removes the ‘Labels and Arrows’ window.
• The ‘Erase Last’ button removes the last label created.
• The ‘Erase All’ button deletes all labels created.
• To overlay the label on the image, the user clicks on the map with the right mouse button.

Figure 8 – The Overlay Labels ‘Labels and Arrows’ window
2.2.2 Pre-Processor

After saving and quitting the ‘Grid Generator’ module, the database created is now ready to be edited using the ‘Pre-Processor’. An icon in the ‘Database Manager’ represents the database created. To run the Pre-Processor complete the following steps:

1. Open the ‘Database Manager’ by double clicking on the icon representing it in the ‘RME procedures page’ (see Figure 3).

2. This pops up another EDGE page containing five database icons, ‘Bathy-Coarse’, ‘Bathy-Fine’, ‘Model Forcing’, ‘Model Res-Coarse’ and ‘Model Res-Fine’ (Figure 9). This is the ‘RME Data Page’ which is used to manage all the databases related to RME.

3. Double-click on the ‘Bathy-Coarse’ icon to open the Regular Grid database.

4. This generates a page containing icons representative of saved databases, which contain gridded bathymetry and station data (Figure 10). Clicking on other databases icons will generate similar pages.

5. Drag the selected database icon to the ‘Pre-Processor’ icon in the ‘RME procedures page’ to activate the ‘Pre-Processor’ module. To facilitate this process place the two EDGE windows (Figure 3 and 10) on top of each other.

6. This pops up the ‘Pre-Processor’ window (Figure 11) which has features to edit bathymetry, stations and define boundary conditions.

    To discuss the individual features, it is necessary to explain the features of the menu bar. The other features of the ‘Pre-Processor’ window are the ‘Zoom’ and the ‘Unzoom’ buttons, and the ‘Lat’ and ‘Lon’ text boxes which were discussed in the Grid Generator module (see Section 2.2.1). The ‘Bathy’ box displays the bathymetry of the grid point nearest to the location of the cursor.

2.2.2.1 Menu Bar

The Menu Bar in the Pre-Processor consists of four interactive menu headers labeled ‘File’, ‘Edit’, ‘Options’ and ‘Overlay’ (Figure 11).
Figure 9 – The Database Manager EDGE window

Figure 10 – The Bathy-Coarse EDGE window
Figure 11 – Pre-Processor GUI
2.2.2.1.1 File Pull-down Menu

The options available in the ‘File’ pull down menu are ‘Save’, ‘ReDraw’, ‘Reset Area’, ‘Iconify’ and ‘Quit’ (Figure 12).

![File Pull-down Menu](image)

Figure 12 – The File pull-down menu for the Pre-Processor

**Save** - This button features its own pull-down menu with options of components to save. Choosing ‘Image’ saves the current image to a file. Choosing ‘Bathymetry’ saves the edited bathymetry stored in the buffer to the database. Choosing ‘Stations & Points’ not only saves the edited stations but also saves locations in the grid to be used by the model to generate time-series files. The ‘Boundary Conditions’ button saves boundary conditions to be used by the model to the database.

**ReDraw** - This option redraws the base bathymetry contours with all the overlaid images.

**Iconify** - The ‘Iconify’ button reduces the Pre-Processor GUI to an icon, which can be retrieved by clicking.

**Quit** - The ‘Quit’ button quits the ‘Pre-Processor’ process. The user must note that all unsaved changes to the edited bathymetry, stations, and boundary condition will be lost if this option is used. The GUI does not prompt the user to save if the ‘Quit’ button is pressed. These options are common to the other modules as well.

2.2.2.1.2 Edit Pull-down Menu

The ‘Edit’ pull-down menu has the options ‘Bathymetry’, ‘Stations’ and ‘Boundary Conditions’ (Figure 13) which generate windows to edit the respective
fields. The editing functions are exclusive of each other and cannot be carried out simultaneously. The editing functions are discussed in detail in the section 2.2.2.2.

![Edit pull-down menu](image)

Figure 13 – The Edit pull-down menu for the Pre-Processor

### 2.2.2.1.3 Options Pull-down Menu


**Plot Types** - This button itself has three choices of plots. Since the bathymetry plot is a contour plot, only the ‘Color Fill’ (Figure 11) and ‘Isoline’ (Figure 14) are applicable.

**Colormap** - This button provides the choice of a ‘Default’, ‘Interpolated’ or a ‘Custom made’ colormap for the contour plots.

**Palette Orientation** - This button gives the choice of horizontal or vertical palette orientation.

**User Draw Options** - This pops up a ‘User Draw Dialog’ window (Figure 15) which gives the choice of changing markers, and coastline line size and color. It also provides the user with a minimum water value for the water mask used during masking, a feature used to facilitate bathymetry editing.

**Plot Draw Options** - This button pops up an ‘Editing Dialog’ window (Figure 16) which permits changes to Isoline type and width. The minimum value of the data point (in this case bathymetry) to be plotted and contouring interval can also be set.
Figure 14 – The Options pull-down menu in the Pre-Processor

Figure 15 – The User Draw Dialog window
Figure 16 - The Editing Dialog window

2.2.2.1.4 Overlay Pull-down Menu


Station Data - Overlaying the station data displays the stations available for assimilation during the model run in this domain (Figure 17). The stations on land and sea are represented by different icons.
Figure 17 – Overlaying stations in the Pre-Processing GUI

Labels - Overlaying labels is identical to the procedure in the Grid Generator module (see Section 2.2.1.1.3).
Coastline - Coastline from several available resolutions can be overlaid from the RME database to facilitate editing (Figure 18).

Figure 18 – Overlaying coastline in the Pre-Processor GUI

Grid - The user has the option of overlaying the model grid, user defined grid, or both (Figure 19). Choosing the ‘Model Grid’ option displays the model grid in red dots for water points and blue dots
for land points. The nested grid is also displayed if one is available. Choosing the 'User Grid' pops up a 'User Grid Dialog' window, which prompts the user to include grid spacing in a box.

Figure 19 – Overlaying grid in the Pre-Processor GUI
Mask - This feature provides the user with the choice of either masking land or water in bathymetry contour plot to assist in editing bathymetry.

2.2.2.2 Editing Features

The three editing processes featured in the ‘Pre-Processor’ are ‘Bathymetry’, ‘Station’, and ‘Boundary Condition’.

2.2.2.2.1 Bathymetry Editing

This feature is activated by the ‘Bathymetry’ option of the ‘Edit’ pull down menu. When activated, it pops up a ‘Bathy Edit Dialog’ window (Figure 20) which has four radio buttons for choosing editing options. To edit bathymetry, the following steps are taken:

1. Click on the ‘Edit’ pull-down menu and then on the ‘Bathymetry’ button.

2. Overlay coastline by clicking the ‘Overlay’ button on the pull-down menu, clicking ‘Coastline’ and then choosing a coastline resolution.

3. Overlay Model Grid by clicking the ‘Overlay’ button on the pull-down menu, clicking ‘Grid’ and then clicking on the ‘Model Grid’ button.

4. If preferred, overlay land or water masking by clicking on the ‘Overlay’ pull-down menu again, clicking on ‘Mask’ and choose the appropriate masking.

5. To edit a point, click on the ‘Edit Point’ radio button in the ‘Bathy Edit Dialog’ window.

6. Set the appropriate conversion value in ‘Enter new value’ box.

7. Click on any grid point with the middle mouse button and convert it from land to water, or water to land, depending upon the relevant selection in the ‘Bathy Edit Dialog’ window. While converting from water to land, when the points are clicked on by the middle mouse button, they are marked by blue crosses. Similarly they are marked with pink crosses when converting from land to water.

8. To edit a group of points select the ‘Edit Group’ option in the ‘Bathy Edit Dialog’ window.
9. Click on several places on the plot with the middle mouse button creating yellow crosses, which are used as zone markers (see Figure 20).

10. Once the zone has been marked, the user can click anywhere within it with the right mouse button. This will mark all relevant grid points with pink (land points if ‘Land to Water’ is selected) or blue crosses (water points if ‘Water to Land’ is selected).

Figure 20 – Bathymetry editing in the Pre-Processor GUI
11. Display the changes in contours using the ‘ReDraw’ option from the ‘File’ pull-down menu.

12. Save the edited bathymetry using the ‘bathymetry’ button in the ‘File/Save’ pull-down menus. Failing to do so will result in the loss of all the edited bathymetry. No warning to save is given if the user decides to quit the ‘Pre-Processor’ without saving.

2.2.2.2 Station Editing

To edit the station data the following steps are followed:

1. Overlay the stations by clicking on the ‘Overlay’ pull-down menu and then clicking on ‘Stations’.

2. Activate the station editor by clicking on the ‘Stations’ button in the ‘Edit’ pull down menu. This pops up the ‘Station Edit Dialog’ window (Figure 21) which contains four radio buttons and eight arrow buttons.

3. Clicking on a station icon will select the station for editing and display its index, name, and position in the ‘Station Edit Dialog’ box.

4. Clicking on the station icon (while pressing the shift key) will display more information on the station, such as component names, amplitudes, and phases. Another ‘Station Edit Dialog’ window pops up with the relevant station information (Figure 21). These can be altered by the user by entering different values.

5. Select the appropriate radio button from the ‘Station Edit Dialog’ box.
6. Once a station has been selected, it can be moved by using the arrow buttons, or alternatively, the station icon can be dragged with the middle mouse button to a different location.

7. Stations can be deleted by selecting the option and clicking on the station icon. The appropriate radio button must be selected by the user to do these actions.

Figure 21 – Station editing in the Pre-Processor GUI
8. To make the deleted station icons disappear, use the redraw feature of the ‘File’ pull-down menu.

9. Save time-series locations by clicking on or near a grid-point which pops up a ‘Point info dialog’ window (Figure 22). Click on the ‘store’ button.

10. Save the edited station data and time-series locations by clicking on the ‘File’ pull-down menu, clicking on the ‘save’ button and then clicking on the ‘Stations & Locations’ button. All edited data will be lost on failure to save before quitting preprocessing.

![Point Info Dialog](image)

Figure 22 – Point info Dialog window of the Pre-Processor

### 2.2.2.2.3 Boundary Condition Editing

This feature is used to initialize the boundary conditions, which is mandatory before a model run. To edit the boundary conditions, the following steps must be followed:

1. Activate the boundary conditions editor by clicking on the ‘Boundary Conditions’ button in the ‘Edit’ pull down menu. The ‘Boundary Condition Edit Dialog’ pops up (Figure 23). This is used to mark the boundary conditions using the direction slider bars and appropriate data.

2. Using the radio buttons in the ‘Boundary Condition Edit Dialog’ window, select the Open Boundaries for which conditions need to be initialized.
3. Click on each of the open boundary specification button sequentially.

4. Select a data source for each open boundary condition after clicking on the boundary condition selected.

5. Operate the slider bars to set up the boundary extents (see Figure 23).

6. When finished with each operation, click ‘Next’ to move to the next boundary and repeat steps 3 to 6.

7. When all boundary conditions have been initialized click on ‘OK’ to end the editing process.

8. Save the boundary conditions created by clicking on the ‘File’ pull-down menu, clicking on the ‘save’ button and then clicking on the ‘Boundary Conditions’ button. As with bathymetry and station editing, the boundary conditions must be saved before quitting the ‘Pre-Processor’ module or all changes stored in the buffer will be lost.

9. Once all necessary changes have been saved, the user can exit ‘Pre-Processor’ by using the ‘Quit’ button of the ‘File’ pull down menu.

The nested grid data can be preprocessed similarly by dragging the nested region icon to the ‘Pre-Processor’. The nested grid icons can be displayed by double-clicking the ‘Bathy-fine’ icon under the ‘Database Manager’. While bathymetry and station editing are permissible for the nested grid, boundary condition editing cannot be carried out as the nested grid obtains its boundary conditions from the regular grid.

2.2.3 Model Packaging

This process is a GUI-less, non-interactive process, which does not require user input. Once the user is finished editing, the edited database can be packaged along with the model code, in preparation for remote or local execution. The packager extracts all the data from binary netCDF files to ASCII in the formats used by the CURReNTSS model. The steps to run the packager are:

1. Start up the packager and drag the current regular database icon from ‘Bathy-coarse’ group of the ‘Database Manager’ to the ‘Model Packager’ icon. The
nested grid icon need not be dragged to the packager as it automatically packages the nested grid files if a nested grid exists.

2. Note the maximum time steps permissible for both the regular and the nested grid which pop up in separate windows (Figure 24) before the packager quits. The Courant-Friedrich-Lewy (CFL) condition for stability is applied to the forcing data to check for the maximum permissible time step that can be used during the model run.

Figure 23 – Boundary Condition editing in the Pre-Processor
3. Check for a file called ‘model.tar’ in the home directory. After going through the CFL condition test, the packager tars all the necessary files along with the model code in a file called ‘model.tar’ and places it in the home directory of the user for remote or local execution.

![xterm shell]

Figure 24 – The CFL condition pop-up in the Model Packager module

### 2.2.4 Remote Execution

This module is required when the user wishes to run the model remotely in a different machine than the one running RME. The user may prefer to do this to shorten model execution time which can take several hours. ‘Remote Execution’ can only be carried out after the model has been packaged. If the model has not been packaged, the ‘Remote Execution’ module will give an error message and terminate. However, if a previously packaged model exists, remote execution will go through model execution without warning the user and return the results to the current database. This will result in erroneous interpretations, especially if the domains are of the same size and the error goes undetected. Care must be taken to ensure that the packager is executed before ‘Local/Remote Execution’.

#### 2.2.4.1 Operational Features

To run the remote execution module, the following steps are taken:

1. Drag the current regular database icon from ‘Bathy-coarse’ of the ‘Database Manager’ to the ‘Remote Execution’ icon in the ‘RME Procedures’ page to start remote execution (see Figure 3). The nested grid icon need not be dragged to the packager as it is automatically selected for execution if the forcing parameters for the nested grid have been packaged.

2. Once the ‘Remote Execution’ process starts, the ‘rem_exe’ window pops up (Figure 25).
3. Fill in the ‘remote login’ parameters in the ‘rem_exe’ window. The ‘Remote HostName’ text box requires the full IP address or pathname of the remote host, or just the name if in the Local Area Network. The users ‘Login name’ and ‘Password’ are also required for ‘ftp’ and ‘telnet’ purposes.

4. Click on the ‘OK’ button. This pops up the model runtime parameter window (Figure 26). Runtime parameters can be altered on every model run without having to preprocess and repackage the model.

![rem_exe](image)

Figure 25 – The Login dialog pop-up for Remote Execution module

5. Fill in the run time parameters using the descriptions given in Appendix F.

6. Set the radio buttons for the various astrodynamical tidal components (M2, S2, N2, etc.).

7. Set the Radiation Boundary Radio buttons.

8. Click the ‘Apply’ button when finished with the runtime parameter window.

9. Click on the ‘Exit’ button. This will exit the window and set the values, include them in the appropriate header file of the model, and add it to the model package. This also initiates the rest of the remote-execution procedures which does not require input and pops up the model execution status window (Figure 27).

10. Click on ‘Exit’ on the model status window once the message ‘Remote Execution Complete’ is displayed on the model execution status window. This could take several hours depending on the model run time on the remote machine.
Figure 26 – The Model runtime parameter dialog box in Remote/Local Execution

During the rest of the remote execution process, the package is transferred by ‘ftp’ to the remote machine, the ‘model.tar’ file ‘untarred’ on the remote machine, the model code compiled and the model executed. The user is kept informed of the model execution status through the status window, which monitors all ‘ftp’ and ‘telnet’ sessions.

After the model run for the regular grid has been completed, the boundary conditions generated for the nested grid are transferred to the appropriate directory and the nested model is compiled and executed. Once the model is finished running on all grids, the result and log files are tarred and brought back to the local machine by 'ftp'. All directories created in the remote machine are deleted. The results are converted locally to netCDF formats to be stored in the ‘results’ database directory. The netCDF result files can be accessed for random visualization during post-processing.
2.2.5 Local Execution

This feature is to be used only if the user intends to execute the model locally on the machine running RME instead of remotely on another machine. ‘Local Execution’, like ‘Remote Execution’ can only be done after packaging has been carried out on the selected database. All precautions specified for the ‘Remote Execution’ module also apply to the ‘Local Execution’ module (see section 2.2.4).

2.2.5.1 Operational Features

The Local Execution Module is executed similarly to Remote Execution (see section 2.2.4.1). The steps involved are:

1. Drag the selected database icon to the 'Local Execution' icon to start local execution. This starts up the ‘Model Parameter’ window (Figure 26).
2. Edit the parameter dialog box as before.

3. Click on the ‘apply’ button.

4. Click on the ‘exit’ button. This brings up the 'status' window (Figure 27) which prints the model standard outputs and keeps the user informed on model progress.

5. Once the model execution is complete click on the ‘Exit’ button on the model status window after ‘Local Execution Completed’ is displayed there. The result files are converted to netCDF formats for visualization like the ‘Remote Execution’ module.

2.2.6 Post-Processor

This module has been designed as a tool for result visualization and data interpretation. After the completion of remote execution, the user can hit the 'back' button on the ‘RME Data Page’ (Figure 9). See section 2.2.2 for details. Once the five database icons are visible, the user can click on either the 'Res-Coarse' icon to view the regular grid results database, or the 'Res-fine' icon to view the nested grid result database. Once the appropriate database is displayed, the relevant icon can be dragged to the 'Post-Processor' icon to activate the process. This pops up a window with the bathymetry plotted as in the ‘Pre-Processor’ (Figure 28), with yellow asterisks marking the saved locations for time series. It also pops up a ‘TimeSeries Dialog’ window (Figure 28).

2.2.6.1 Menu Bar

The Menu Bar in the Post-Processor consists of four interactive menu headers labeled: ‘File’, ‘Graphics’, ‘Options’ and ‘Overlay’ (Figure 28). The pull down menu for ‘File’, ‘Options’ and ‘Overlay’ are identical to that of the Pre-Processor (see section 2.2.2.1). The ‘Graphics’ header replaces the ‘Edit’ header. The pull down features of the ‘Graphics’ interactive header are discussed in the next section.
Figure 28 – Time-series dialog window in the Post-Processor GUI

2.2.6.2 Graphics Features

2.2.6.2.1 Time Series

The time-series Dialog window is the default displayed when running the Post-Processor. It can also be displayed by clicking the appropriate graphics button. The steps involved in displaying time-series results are:

1. Click on the radio buttons to select the parameters for which time-series is required in the ‘Time Series Dialog window (Figure 28).

2. Select the time-span of the time-series plot by operating the slider bar in the ‘Time Series Dialog’ window.

3. Click on the chosen station with the middle mouse button to display the time-series at a particular saved location, which are marked with yellow asterisks. This pops up a time-series window (Figure 29) which displays the time-series of the selected parameters. If no time-series location has been saved, a blank window appears with the ‘no time series file’ message in the ‘Remark’ box in the ‘Time Series Dialog’ window. To display time-series of another location, simply click on another saved location asterisk with the middle mouse button and the same window displays a time-series of the selected location.

2.2.6.2.2 Co-tidal Analysis

The steps to display cotidal analyses of the region are:

1. Click on the ‘Cotidal Analysis’ toggle button under the ‘Graphics’ pull down menu. This pops up a ‘Cotidal Analysis Dialog’ window (Figure 30).

2. The co-amplitude and co-phase of the ‘Sea Surface Height’ (SSH) is displayed in the main window. The co-amplitude is displayed in color filled contours and the co-phase is overlaid in isoline contours.

3. To display the cotidal analyses of other parameters, such as the U component and V component of the current velocity, select the desired radio button on the ‘Cotidal Analysis Dialog’ window and click on the ‘Apply’ button.
Figure 29 – The time-series pop-up window in the Post-Processor
Figure 30 – The co-tidal analysis window in the Post-Processor

2.2.6.2.3 Snap Shots/Animations

The followings steps are required for viewing snap shots and animations of SSH and current velocity:
1. Click on the ‘Snap Shot/Animation’ button on the Graphics pull down menu. This generates a ‘Snap Shot/Animation Dialog’ window (Figure 31) and displays the SSH in color filled contours in the main window (Figure 32).

2. The SSH is overlaid with velocity vector arrows the size of which varies with magnitude.

3. To display snap shots of SSH data overlaid with velocity vectors of another time frame, select an appropriate time from the ‘Start time’ text box in the ‘Snap Shot/Animation Dialog’ window and click on the ‘Snap Shot’ button.

4. To animate several snap shots, select a time from the ‘End time’ text box in the ‘Snap Shot/Animation Dialog’ window and the time steps using the ‘Step’ slider bar.

5. Click on the ‘Animate’ button to animate the snapshots sequentially.

The user can manipulate the speed and direction of the animation as well as use other features such as pause and oscillate using the keyboard. The cursor must be in the animation window when the user types in the keyboard commands. It must be noted that it takes several minutes for the animation window to pop up, and depending on the processor speed and number of frames to animate, several minutes for the animation to stabilize. Only then should any attempts be made to control it using the keyboard. The keys used to control the animation are as follows.

**Keyboard control:**

n - go 1 frame forward  
f - loop forward  
d - decrease speed  
b - go 1 frame backward  
r - loop backward  
i - increase speed  
s - go to the starting frame  
o - oscillate  
q - quit  
l - go to the last frame  
p - pause
Figure 31 – The snap-shot/animation dialog window in the Post-Processor

2.2.6.2.4 Tidal Event Log

To view the tidal event log:

1. Click on the ‘Tidal Event Log’ toggle button in the Graphics pull down menu. This generates the ‘Tidal Event Log Dialog’ pop-up window (Figure 33).

2. The bathymetry is displayed again in the main Post-Processor window with the yellow asterisks marking the saved locations (Figure 28).

3. Select the range over which to generate a tidal event log using the ‘Start time’ and ‘End time’ boxes in the ‘Tidal Event Log Dialog’ window.

4. Click on the yellow asterisk marking the selected saved location with the middle mouse button.

5. This pops up the ‘Tidal Event Log’ main window (Figure 34). The red line denotes SSH and the green line velocity magnitude. The log in the lower text box of the window has time in Julian day, elevation in meters, velocity in cm/s and direction in degrees.
Figure 32 – Snap shot from the Post-Processor
Figure 33 – Tidal event log dialog in the Post-Processor
Figure 34 – Tidal event log pop-up window in the Post-Processor
3.0 Error Messages

Some of the user error messages and descriptions are provided below. The messages usually appear in the 'Remark' box of the module GUIs. If there are any other problems with the RME that the System Administrator cannot fix, contact (228) 688-4218(tel); (228) 688-7100(fax) or email: corbin@cast.msstate.edu.

3.1 Grid Generator Module

'Min lon must be smaller than max lon!' - This error is displayed when the user puts in a larger value for the Min lon than Max lon in the region coordinates text box.

'Min lat must be smaller than max lat!' - Same as above for latitude.

'Select Bathymetry first!' - Displayed when the user tries to save a region without selecting bathymetry database.

'Select Station data first!' - Displayed when the user tries to save a region without selecting a station database file.

'A coarse grid must be selected for nesting!' - Displayed when the user tries to nest a region inside the world map without selecting a saved region as a regular grid first.

'A fine grid has been created for this coarse grid!' - Displayed when the user attempts to create two nests for the same regular grid.

'Cannot create a fine grid inside a fine grid!' - Displayed when the user selects a nested grid and tries to nest a region in it.

'A nested grid resolution fraction must be selected!' - Displayed when the user tries to save a nested grid without selecting a nested grid fraction.

'X resolution is invalid!' - Displayed when the user types in an invalid grid resolution in the X resolution box or leaves it empty.
‘Y resolution is invalid!’ - Displayed when the user types in an invalid grid resolution in the Y resolution box or leaves it empty.

‘Region 'region name' has already been defined!’ - Displayed when the user tries to reuse a region name while saving.

‘Cannot open database ..path/regionDB!’ - Displayed when the region database information file for the user in the directory ‘username_db’ is missing.

‘Cannot open database ..path/bathyDB!’ - Displayed when the bathymetry database information file for the user in the directory ‘username_db’ is missing.

‘Cannot overwrite database ..path/regionDB!’ - Displayed when the user does not have write permissions for the ‘regionDB’ file or the directory.

‘Error writing to ..path/regionDB!’ - Similar to the previous error message, when the ‘regionDB’ file has been moved.

‘Select a region to delete!’ - Displayed when the user has not selected a region from the ‘Defined Grids’ box and presses the ‘delete’ button.

3.2 Pre-Processor

‘Fail to do window dump using xtof!’ - Displayed when the user tries to save the image in the preprocessor but the ‘xtof’ command cannot be executed.

‘Error writing stn file!’ - Displayed when the user tries to save the station file and does not have write permissions in the ‘regions’ directory.

‘Error ingesting domain file! (global/desai data)’ - Displayed when the boundary condition netCDF files are not in the right format.

‘/...path/RME/data/Filename does not exist!’ - Displayed when the boundary condition files do not exist or are in the wrong directory.

‘Error! Output file not created!’ - Displayed when the user tries to save boundary conditions for a location but does not have write permissions to the ‘/..path/username_db/regions/regionname/’ directory.
'Editing stations! Can't edit bathymetry!' - Displayed when the user presses the 'edit bathymetry' button without dismissing the 'Station Edit Dialog' window.

'Editing boundary conditions! Can't edit bathymetry!' - Displayed when the user presses the 'edit bathymetry' button without dismissing the 'Boundary Edit Dialog' window.

'Editing bathymetry! Can't edit stations!' - Displayed when the user presses the 'edit stations' button without dismissing the 'Bathymetry Edit Dialog' window.

'Editing boundary conditions! Can't edit stations!' - Displayed when the user presses the 'edit stations' button without dismissing the 'Boundary Edit Dialog' window.

'Editing bathymetry! Can't edit boundary conditions!' - Displayed when the user presses the 'edit boundary conditions' button without dismissing the 'Bathymetry Edit Dialog' window.

'Editing stations! Can't edit boundary conditions!' - Displayed when the user presses the 'edit boundary conditions' button without dismissing the 'Station Edit Dialog' window.

'Cannot undo edit!' - Displayed when the particular editing routine has already been saved and the buffer cannot revert to the older version from the file.

'Overlay stations first before editing!' - Displayed when the user presses the 'edit stations' button without overlaying stations first.

'No station data!' - Displayed when the station file has not been properly saved using the grid generator or has been removed.

'Specify a direction first!' - Displayed when the user has not selected a direction in the 'Boundary Edit Dialog' box and tries to edit a boundary.

'Specify a data source first!' - Displayed when the user has not selected a data source for the boundary conditions in the 'Boundary Edit Dialog' box and tries to edit a boundary.

'No begin station index!' - Displayed when the station index is missing.
3.3 Model Packager

Since this is a GUI-less interface there is no inherent error display provided. All errors are UNIX related and are on the window from which RME was run. Most errors stem from absence of files, wrong pathnames and read/write permissions.

Some common errors are given below:

i. Cannot access file: No such file or directory
ii. cp: file: Permission denied
iii. mv: file: Permission denied
iv. tar: file.tar: Permission denied

3.4 Remote/Local Execution

All errors in these packages are displayed in the ‘Model Run Status’ window (Figure 27). They are mostly model run errors or are ‘ftp’ and ‘telnet’ related for ‘remote execution’. Some common errors are:

‘u10’ file not created’ - Displayed when the runtime parameters are not correctly specified or the user does not have write permission for the directory in which the ‘.2du10’ file is being created.

‘Invalid command’ - PERL interpreter not available or the wrong shell is being used.

‘hostname invalid or cannot be reached’ - Displayed when the hostname specified by the user is wrong or the network is down.

‘invalid filename’ - Displayed when a filename is different than what the model expects.

‘invalid directory’- Displayed when the directory path is invalid.

3.5 Post-Processor

‘Cannot malloc for file name!’ – Memory allocation error.
‘No bathy file u40.nc in input directory!’ - Displayed when the bathymetry netCDF file has been removed after packaging from the ‘..path/regions/regionname/’ directory.

‘Cannot read bathy u40.nc data!’ - No read permissions for the bathymetry netCDF file.

‘No cotidal analysis file cot2d.nc in input directory!’ - The cotidal netCDF file was not created. Either the model did not produce the cotidal analysis file, or the filter was unable to convert it to a format recognized by the Post-Processor module.

‘Error malloc for movie data!’ – Memory allocation error.

‘Draw a contour first!’ - Displayed when the user tries to overlay anything without the main window displaying contours.

‘Fail to do window dump using xtof?’ - Displayed when the user tries to save the image in the Post-Processor but the ‘xtof’ command cannot be executed.

‘No station data!’ - Displayed when the station file has not been properly saved using the grid generator or has been removed.

‘No time series file in input directory!’ - The time-series netCDF file (tsr2d.nc) was not created. Either the model did not produce the time-series files as no locations were saved by the user, or the filter was unable to convert it to a format recognized by the Post-Processor module.

‘Error malloc for time series dim!’ - Memory allocation error.

‘No movie file mov2d.nc in input directory!’ - The movie netCDF file (mov2d.nc) was not created. Either the model did not produce the movie file, or the filter was unable to convert it to a format recognized by the Post-Processor module.

‘Error malloc for movie dim!’ - Memory allocation error.

‘Fail to animate using xa!’ - There was a failure to create animation of the snapshots from the movie file.
4.0 NOTES

4.1 System Considerations

RME is intended for installation in and execution by Silicon Graphics, Incorporated computing platforms. Installation is site specific and tailored to the environment. Appendix D provides information specific to installation of the RME. While the RME may be executed from an X-terminal, some graphical screens produced by RME are memory intensive and may cause termination of the software if the memory of the X-terminal is insufficient. The RME may also be executed remotely from other X-Windows environments such Sun Microsystems and LINUX by changing appropriate display settings. However the graphics may sometime exceed monitor dimensions due to varying screen resolutions of different systems.

4.2 System/Software Requirements

RME is an integrated software system that requires the use of some commercial software.

- RME was designed for execution under control of the UNIX operating system on Silicon Graphics hardware.

- RME requires the X-Windows environment

- The Open Software Foundation's (OSF) Motif Toolkit (library) must be used and be available in the execution environment.

- A routine version of NCAR Graphics software package must be installed on the system and be available in the execution environment to support RME graphical display options.

- A PERL5 interpreter must be used in the execution environment.

- RME is an interactive application. It supports all standard X-Windows mouse and keyboard functions.
The software code for this version of RME was compiled using C, C++, and FORTRAN Compilers.

4.3 Directory Map

RME software executables have been designed to execute using directory paths defined via UNIX environmental parameters and path names defined within user ‘login’ or ‘cshrc’ or ‘profile’ files. These parameters must be determined during installation since they are system dependent. A complete directory tree structure of the RME is provided in Appendix E.

4.4 Security

The RME neither supports nor restricts the overall classification of the computing environment. The restrictions imposed on databases of individual users are left to the system administrator of the machine on which the RME is installed.
APPENDIX A

Glossary of Terms

Bathymetry - Pertaining to depth of ocean.

Button - When used in relation to the mouse device, a button is one of three pressure switches, which may be pressed/clicked to control some feature of the screen display. When used in relation to the monitor display, a button is a labeled area of the on-screen-graphical design that resembles a switch, which can be made active by positioning cursor with mouse and clicking.

Click - The act of pressing a button on a mouse. The term ‘click on’, or simply ‘click’, is frequently used to indicate that the user should maneuver the mouse cursor to a specified location on the screen (usually an area designed to resemble a button) and controlled from the keyboard, press (click) the appropriate button on the mouse.

Cursor - A graphical symbol that identifies a portion on a computer monitor screen. A cursor is sometimes controlled by moving a mouse device. Otherwise, it is controlled from the keyboard, usually with the arrow keys.

Display - Synonymous with the computer monitor screen; also, to demonstrate or to show.

Drag - The act of pressing and holding a button on the mouse device and moving the mouse to control a cursor's position on the monitor screen. The purpose of dragging the mouse is to define an area on the screen or to move a graphical object to another location.

Graphical User Interface (GUI) - RME module responsible for interfacing with the user and controlling the functionality of the main RME display.

Julian - The day of the year according to the Julian calendar which begins on the first day of the year (January 1). A Julian date does not include a year as part of its simple format (see Appendix G).
List - A simple series of words or numerals.

Listbox - An outlined area of the display which contains a list of textual information. Selection of text within a list is accomplished by placing the mouse cursor over the appropriate entry and clicking a button on the mouse.

Mouse - A hand controlled device used to interact with images displayed on the computer monitor screen. When a mouse is moved, a cursor on the screen moves in the same direction as the mouse. One or more buttons may be present on a mouse for invoking an action on screen at the corresponding cursor position.

Profile - A sequential listing of parameters keyed to a reference structure. A bathymetric profile contains sequential depth/parameter groups.

Pull-Down Menu - A listing of procedural options that appears in response to activation of an appropriately labeled (visible) button referred to as the menu header. Options are selected by clicking on the menu header to display the options, followed by clicking the button labeled to indicate the desired option.

Radio Button – A clickable button to either select or de-select an option.

Rubber-band - The act of dragging the mouse to define an area on the screen. A mouse button is pressed and held while the mouse is maneuvered to position the on-screen cursor at a desired final position; then, the mouse button is released.

Screen - The display surface of a computer video monitor where images appear.

Scroll Bar - The graphical image of a narrow bar with arrows embedded at both ends and, optionally, a movable (sliding) button between them. The scroll bar is used to position a portion of an image or text for viewing inside a bound area that is smaller than the whole image or text. Scrolling is accomplished by placing the mouse cursor on one of the arrows and pressing the mouse button. Scrolling may also be accomplished by placing the mouse cursor over the sliding button (if present) and dragging the sliding button to a new position along the bar.

Slider Bar - Similar to a scroll bar but does not have arrows embedded on ends. Instead has a siding button which can be manipulated with the mouse.

Tar – A UNIX command to archive files in a single file or tape for back up and transport purposes. Also used to describe such archiving (‘tarring’, ‘tarred’, etc.).
Textbox - An outlined area of the display that contains textual information. Text in a textbox may sometimes be edited; however, the usual purpose of a textbox is to provide information to the user.

Untar - Extracting files from a 'tarred' archive (see tar).

Unzoom - The graphical scaling process whereby a screen display item is reduced in size (also see Zoom).

Widget - A graphical device capable of receiving input from the keyboard and the mouse and communicating with an application or another widget by means of a callback. Every widget is a member of only one class and always has a window associated with it. (from: OSF/Motif Programmer's Guide, Rev. 1.1 Open Software Foundation, Prentice Hall, Englewood Cliffs, NJ, 1991, p. GL-13.)

Window - An outlined area of the screen whose contents are confined to the outlined boundary and controlled by user interaction (with buttons, menus, etc.). A window is usually a top-level structure closely tied to the operating environment of the computer.

Zoom - The graphical scaling process whereby a screen display item is enlarged in size (also see Unzoom).
## APPENDIX B

### Abbreviations Used

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange</td>
</tr>
<tr>
<td>Bathy</td>
<td>Bathymetry</td>
</tr>
<tr>
<td>Bdry</td>
<td>Boundary</td>
</tr>
<tr>
<td>CAST</td>
<td>Center for Air Sea Technology</td>
</tr>
<tr>
<td>CFL</td>
<td>Courant-Frederich-Lewy condition</td>
</tr>
<tr>
<td>CURReNTSS</td>
<td>Colorado University Rapidly Relocatable Nestable Tidal Storm Surge Model</td>
</tr>
<tr>
<td>DB/db</td>
<td>Database</td>
</tr>
<tr>
<td>DOD</td>
<td>Department of Defense</td>
</tr>
<tr>
<td>EDGE</td>
<td>Extensible Distributed Graphical Environment</td>
</tr>
<tr>
<td>ftp</td>
<td>File transfer protocol</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IM</td>
<td>Number of grid points in the model domain in the east-west(X) direction</td>
</tr>
<tr>
<td>JM</td>
<td>Number of grid points in the model domain in the north-south(Y) direction</td>
</tr>
<tr>
<td>Lat</td>
<td>Latitude</td>
</tr>
<tr>
<td>LLT</td>
<td>Latitude Longitude and Time</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Full Form</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Lon</td>
<td>Longitude</td>
</tr>
<tr>
<td>Max</td>
<td>Maximum</td>
</tr>
<tr>
<td>Min</td>
<td>Minimum</td>
</tr>
<tr>
<td>MSU</td>
<td>Mississippi State University</td>
</tr>
<tr>
<td>ONR</td>
<td>Office of Naval Research</td>
</tr>
<tr>
<td>OSF</td>
<td>Open Software Foundation</td>
</tr>
<tr>
<td>RME</td>
<td>Relocatable Modeling Environment</td>
</tr>
<tr>
<td>SGI</td>
<td>Silicon Graphics Incorporated</td>
</tr>
<tr>
<td>SSH</td>
<td>Sea Surface Height</td>
</tr>
<tr>
<td>Stn</td>
<td>Station</td>
</tr>
<tr>
<td>2-D</td>
<td>Two-Dimensional</td>
</tr>
<tr>
<td>3-D</td>
<td>Three-Dimensional</td>
</tr>
</tbody>
</table>
APPENDIX C

RME Database Configuration System

Most of the databases used in the RME are stored under a ‘username_db’
directory which is created under the ‘../path/RME/rme_db’ directory when the user
uses RME for the first time. Three directories, ‘bathy’, ‘station’ and ‘regions’ are
created under ‘username_db’. The ‘bathy’ directory contains a link to the ETOPO5
global bathymetric data stored under the ‘../path/RME/rme_db/defaults/bathy’
directory and the ‘station’ directory contains a link to the ‘tidal_stn.dat’ file in the
‘../defaults/station’ directory. Information on the bathymetry datafiles in the ‘bathy’
directory is stored in a file named ‘bathyDB’ under the ‘username_db’ directory.
Any new additions that the user chooses to make to the bathymetry database will be
in the ‘../username_db/bathy’ directory and has to be in the ‘lon-lat-bathy’ format.
The information about the new bathymetry database must be updated in the bathyDB
file in the following format:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Min. Lon</th>
<th>Min. Lat.</th>
<th>Max. Lon.</th>
<th>Max. Lat.</th>
<th>No. of lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eg. ysc2dsnd</td>
<td>117.625</td>
<td>24.6334</td>
<td>129.292</td>
<td>40.9667</td>
<td>17204</td>
</tr>
</tbody>
</table>

Another directory called ‘regions’ is created under the ‘username_db’
directory when the user stores a region using the Grid Generator. Information on the
regions is stored in a binary file called regionDB and is not user accessible. A
‘username_db’ directory is created under the ‘..path/RME/edge_db’ directory which
contains links to the ‘..path/RME/edge_db/rme_db’ directory which has all the RME
information (icons, executables, etc.) for the EDGE environment.
APPENDIX D

RME Installation Procedures

These procedures are included in the RME package in a file named ‘readme.txt’ under the main ‘RME’ directory.

1.0 System Requirements

SGI workstation operating IRIX 6.2
2.5 G Bytes of hard disk space

2.0 Installation Procedures

1. Include the following statement in the ‘.cshrc’ file if you are using C, Z, or T shells. Do not use ksh, bash, or bsh shell as the Remote/Local execution modules are designed to work on ‘csh’ scripts and will not work in these shells.

(a) Insert the following statement after all setenv commands:

    setenv RME_PATH pathname/RME

(b) Insert the following statement after all setpath commands:

    setpath=($path $RME_PATH)

where ‘pathname’ is the path of the directory containing RME.tar.gz

(ii) Type ‘source .cshrc’

(iii) Change directory to the directory that contains RME.tar.gz

(iv) Unzip and extract RME.tar.gz by typing:
'gunzip RME.tar.gzl tar xvf'

(v) Install RME by typing:

'Install all'

(vi) Start RME by typing

'rme2d'

(vii) Once the installation is complete, test each module to ensure they work properly. Report any problems to rme-developers@cast.msstate.edu.
APPENDIX E

RME Directory Structure

Directory Tree Structure          Relevant Description

RME
|-- Images
|  |-- icons
|  |-- xvpics
|  |-- Movies
|  |__ bin
|  |__ coastlines_db
|  |__ data
|  |__ edge_bin
|  |__ edge_db
|  |  |-- default_db
|  |  |-- rme_db
|  |  |-- tides_db
|  |  |__ tmp
|  |  |__ edge_profile
|  |  |__ root
|  |  |-- edge_sys
|  |  |__ apd
|  |  |__ profile
|  |  |__ scripts
|  |  |__ sys_db
|  |  |  |-- Images
|  |  |  |__ icons
|  |  |  |__ work
|  |  |  |  |__ icons
|  |  |__ edge_tmp
|  |  |__ html
|  |  |__ ncl
|  |  |__ profile_db
|  |  |__ rme_db
|  |  |  |-- defaults
|  |  |  |__ bathy
|  |  |  |__ station
|  |  |__ rme_home
|  |  |__ ImgTool
|  |  |  |-- int1
|  |  |  |__ jpeg
|  |  |  |__ tiff
|  |  |  |__ xpm
|  |  |  |__ lib
|  |  |__ Mpp
|  |  |__ NETTool
|  |  |  |-- CorbaClient
|  |  |  |__ Ilu
|  |  |  |__ NETLib
|  |  |  |__ NETLib2

All the images are stored in this directory

The coastline database is stored here

The boundary conditions from the Global run and Desai-Wahr

All the module executable go here for execution from EDGE

Personalised edge db in a 'username_db' directory are created here

Initial EDGE db copied to directory 'username_db'

Personlized profiles for users created in username directories

Edge system codes and icons

RME database personalized user db created
from the defaults directory

All RME source code stored under this directory

The Motif Plus Plus GUI library
Nettool for EDGE

contd....
The boundary condition extraction program

All the boundary condition data
All the RME header files

RME library
Local execution module

Model source code in FORTRAN

NCAR graphics code

netCDF read write routines used by the GUI
Remote execution module
Remote execution executables

Common main programs for all modules
Grid Generator module
EDGE object Manager
Post-Processor module
Pre-Processor module

Model Packager module
Station extractor module
Bathymetry gridding module
APPENDIX F

Model Parameters

1. **Runtime Parameters** - These parameters are entered by the user in the runtime parameter window (See Figure 26 and Section 2.2.4.1) and are stored in the model header file ‘...2du10’.

<table>
<thead>
<tr>
<th>Parameter Window Name</th>
<th>Model Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>MODE</td>
<td>If Mode=2-&gt;2-D calculation is performed Mode=3-&gt;3-D prognostic calculation is performed Mode=4-&gt;3-D diagnostic calculation is performed</td>
</tr>
<tr>
<td>RStart</td>
<td>RSTART</td>
<td>Flag for restart - 0 means start from rest 1 requires sea2du70 file</td>
</tr>
<tr>
<td>Days</td>
<td>DAYS</td>
<td>Number of Days to run the model</td>
</tr>
<tr>
<td>RampUp</td>
<td>RAMPUP</td>
<td>Number of Days over which the model is ramped up</td>
</tr>
<tr>
<td>Date</td>
<td>DATE</td>
<td>Julian day the model run is started</td>
</tr>
<tr>
<td>Year</td>
<td>YEAR</td>
<td>Year of the model run (1975 or later)</td>
</tr>
<tr>
<td>RstartInt</td>
<td>SAVEF</td>
<td>Time interval in days at which the restart file ..2dfld) is saved</td>
</tr>
<tr>
<td>SaveT</td>
<td>SAVET</td>
<td>Interval at which to save the ‘..ctl’ file</td>
</tr>
<tr>
<td>SerInt</td>
<td>Saves</td>
<td>Interval at which the ‘..ser’ file is saved</td>
</tr>
<tr>
<td>MovieInt</td>
<td>SAVEM</td>
<td>Interval at which the ‘movie’ file ‘...2dmov’ is saved</td>
</tr>
<tr>
<td>PrintDlog1</td>
<td>PRTD1</td>
<td>Interval in which to write to standard output</td>
</tr>
<tr>
<td>Parameter Window Name</td>
<td>Model Variable Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>PrintDlog2</td>
<td>PRTD2</td>
<td>Interval in which data is written to standard output later in the model run</td>
</tr>
<tr>
<td>StartSer</td>
<td>SWITCHS</td>
<td>Day at which to start 'ser' file</td>
</tr>
<tr>
<td>DragCoeff</td>
<td>CD</td>
<td>Drag coefficient to use for bottom friction usually 0.0025</td>
</tr>
<tr>
<td>HorEddy</td>
<td>HORCON</td>
<td>A number without dimensions used in calculating the horiz.eddy diffusivity (0.01-0.1)</td>
</tr>
<tr>
<td>AstroFlag</td>
<td>ITIDE</td>
<td>Flag for astronomical forcing</td>
</tr>
<tr>
<td>AstroDate</td>
<td>STIDE</td>
<td>Date to start tidal forcing</td>
</tr>
<tr>
<td>StnAssm</td>
<td>ITDASM</td>
<td>Flag to assimilate station data</td>
</tr>
<tr>
<td>StnInclusn</td>
<td>IALL</td>
<td>Flag to assimilate all stations</td>
</tr>
<tr>
<td>FractN</td>
<td>FRACTN</td>
<td>Weight to be given to data assimilation</td>
</tr>
<tr>
<td>DTA</td>
<td>DTA</td>
<td>Assimilation time step (multiple of DTE)</td>
</tr>
<tr>
<td>ISLV</td>
<td>ISLV</td>
<td>Used in sr genCtlFile call</td>
</tr>
<tr>
<td>ISLASM</td>
<td>ISLASM</td>
<td>Used in sr genCtlFile call</td>
</tr>
<tr>
<td>SSLV</td>
<td>SSLV</td>
<td>Used in sr genCtlFile call</td>
</tr>
<tr>
<td>MinWDpth</td>
<td>MINDEP</td>
<td>Minimum water Depth</td>
</tr>
<tr>
<td>ExtStep</td>
<td>DTE</td>
<td>External Time Step</td>
</tr>
<tr>
<td>IntStep</td>
<td>DTI</td>
<td>Internal Time Step</td>
</tr>
<tr>
<td>StartMovie</td>
<td>SWITCHM</td>
<td>Day to start the movie file</td>
</tr>
<tr>
<td>Parameter Window Name</td>
<td>Model Variable Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>HorKinVis</td>
<td>AAA</td>
<td>Const. val used to initialize hor. kin. viscosity array [m² s⁻¹]</td>
</tr>
<tr>
<td>Iwind</td>
<td>IWIND</td>
<td>Flag to include wind forcing</td>
</tr>
<tr>
<td>Iriver</td>
<td>IRIVER</td>
<td>Flag to include river forcing</td>
</tr>
</tbody>
</table>

2. **Other Model Header parameters set by GUI** - These parameters are set in the header file Ogcm1.h

<table>
<thead>
<tr>
<th>Model Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM</td>
<td>Number of grid points in x direction</td>
</tr>
<tr>
<td>JM</td>
<td>Number of grid points in y direction</td>
</tr>
<tr>
<td>SEA</td>
<td>Name of sea, hardwired to 'coa' for regular and 'fin' for nested grids in RME</td>
</tr>
<tr>
<td>SOUTH</td>
<td>Flags for boundary conditions</td>
</tr>
<tr>
<td>EAST</td>
<td></td>
</tr>
<tr>
<td>NORTH</td>
<td></td>
</tr>
<tr>
<td>WEST</td>
<td></td>
</tr>
<tr>
<td>ALATSW</td>
<td>Initial origin latitude</td>
</tr>
<tr>
<td>ALONSW</td>
<td>Initial origin longitude</td>
</tr>
<tr>
<td>DLON</td>
<td>X - grid resolution</td>
</tr>
<tr>
<td>DLAT</td>
<td>Y - grid resolution</td>
</tr>
<tr>
<td>NST</td>
<td>Number of saved locations</td>
</tr>
<tr>
<td>IST(NST)</td>
<td>X-direction grid position array for the saved locations</td>
</tr>
<tr>
<td>JST(NST)</td>
<td>Y-direction grid position array for the saved locations</td>
</tr>
</tbody>
</table>
# APPENDIX G

## Julian Date Calendar

<table>
<thead>
<tr>
<th>Day</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sept</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
<th>Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>32</td>
<td>60</td>
<td>91</td>
<td>121</td>
<td>152</td>
<td>182</td>
<td>213</td>
<td>244</td>
<td>274</td>
<td>305</td>
<td>335</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>33</td>
<td>61</td>
<td>92</td>
<td>122</td>
<td>153</td>
<td>183</td>
<td>214</td>
<td>245</td>
<td>275</td>
<td>306</td>
<td>336</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>34</td>
<td>62</td>
<td>93</td>
<td>123</td>
<td>154</td>
<td>184</td>
<td>215</td>
<td>246</td>
<td>276</td>
<td>307</td>
<td>337</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>35</td>
<td>63</td>
<td>94</td>
<td>124</td>
<td>155</td>
<td>185</td>
<td>216</td>
<td>247</td>
<td>277</td>
<td>308</td>
<td>338</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>36</td>
<td>64</td>
<td>95</td>
<td>125</td>
<td>156</td>
<td>186</td>
<td>217</td>
<td>248</td>
<td>278</td>
<td>309</td>
<td>339</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>37</td>
<td>65</td>
<td>96</td>
<td>126</td>
<td>157</td>
<td>187</td>
<td>218</td>
<td>249</td>
<td>279</td>
<td>310</td>
<td>340</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>38</td>
<td>66</td>
<td>97</td>
<td>127</td>
<td>158</td>
<td>188</td>
<td>219</td>
<td>250</td>
<td>280</td>
<td>311</td>
<td>341</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>39</td>
<td>67</td>
<td>98</td>
<td>128</td>
<td>159</td>
<td>189</td>
<td>220</td>
<td>251</td>
<td>281</td>
<td>312</td>
<td>342</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>40</td>
<td>68</td>
<td>99</td>
<td>129</td>
<td>160</td>
<td>190</td>
<td>221</td>
<td>252</td>
<td>282</td>
<td>313</td>
<td>343</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>41</td>
<td>69</td>
<td>100</td>
<td>130</td>
<td>161</td>
<td>191</td>
<td>222</td>
<td>253</td>
<td>283</td>
<td>314</td>
<td>344</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>42</td>
<td>70</td>
<td>101</td>
<td>131</td>
<td>162</td>
<td>192</td>
<td>223</td>
<td>254</td>
<td>284</td>
<td>315</td>
<td>345</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>43</td>
<td>71</td>
<td>102</td>
<td>132</td>
<td>163</td>
<td>193</td>
<td>224</td>
<td>255</td>
<td>285</td>
<td>316</td>
<td>346</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>44</td>
<td>72</td>
<td>103</td>
<td>133</td>
<td>164</td>
<td>194</td>
<td>225</td>
<td>256</td>
<td>286</td>
<td>317</td>
<td>347</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>45</td>
<td>73</td>
<td>104</td>
<td>134</td>
<td>165</td>
<td>195</td>
<td>226</td>
<td>257</td>
<td>287</td>
<td>318</td>
<td>348</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>46</td>
<td>74</td>
<td>105</td>
<td>135</td>
<td>166</td>
<td>196</td>
<td>227</td>
<td>258</td>
<td>288</td>
<td>319</td>
<td>349</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>47</td>
<td>75</td>
<td>106</td>
<td>136</td>
<td>167</td>
<td>197</td>
<td>228</td>
<td>259</td>
<td>289</td>
<td>320</td>
<td>350</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>48</td>
<td>76</td>
<td>107</td>
<td>137</td>
<td>168</td>
<td>198</td>
<td>229</td>
<td>260</td>
<td>290</td>
<td>321</td>
<td>351</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>49</td>
<td>77</td>
<td>108</td>
<td>138</td>
<td>169</td>
<td>199</td>
<td>230</td>
<td>261</td>
<td>291</td>
<td>322</td>
<td>352</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>50</td>
<td>78</td>
<td>109</td>
<td>139</td>
<td>170</td>
<td>200</td>
<td>231</td>
<td>262</td>
<td>292</td>
<td>323</td>
<td>353</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>51</td>
<td>79</td>
<td>110</td>
<td>140</td>
<td>171</td>
<td>201</td>
<td>232</td>
<td>263</td>
<td>293</td>
<td>324</td>
<td>354</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>52</td>
<td>80</td>
<td>111</td>
<td>141</td>
<td>172</td>
<td>202</td>
<td>233</td>
<td>264</td>
<td>294</td>
<td>325</td>
<td>355</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>53</td>
<td>81</td>
<td>112</td>
<td>142</td>
<td>173</td>
<td>203</td>
<td>234</td>
<td>265</td>
<td>295</td>
<td>326</td>
<td>356</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>54</td>
<td>82</td>
<td>113</td>
<td>143</td>
<td>174</td>
<td>204</td>
<td>235</td>
<td>266</td>
<td>296</td>
<td>327</td>
<td>357</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>24</td>
<td>55</td>
<td>83</td>
<td>114</td>
<td>144</td>
<td>175</td>
<td>205</td>
<td>236</td>
<td>267</td>
<td>297</td>
<td>328</td>
<td>358</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>56</td>
<td>84</td>
<td>115</td>
<td>145</td>
<td>176</td>
<td>206</td>
<td>237</td>
<td>268</td>
<td>298</td>
<td>329</td>
<td>359</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>57</td>
<td>85</td>
<td>116</td>
<td>146</td>
<td>177</td>
<td>207</td>
<td>238</td>
<td>269</td>
<td>299</td>
<td>330</td>
<td>360</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>27</td>
<td>58</td>
<td>86</td>
<td>117</td>
<td>147</td>
<td>178</td>
<td>208</td>
<td>239</td>
<td>270</td>
<td>300</td>
<td>331</td>
<td>361</td>
<td>27</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>59</td>
<td>87</td>
<td>118</td>
<td>148</td>
<td>179</td>
<td>209</td>
<td>240</td>
<td>271</td>
<td>301</td>
<td>332</td>
<td>362</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>*</td>
<td>88</td>
<td>119</td>
<td>149</td>
<td>180</td>
<td>210</td>
<td>241</td>
<td>272</td>
<td>302</td>
<td>333</td>
<td>363</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>89</td>
<td>120</td>
<td>150</td>
<td>181</td>
<td>211</td>
<td>242</td>
<td>273</td>
<td>303</td>
<td>334</td>
<td>364</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>90</td>
<td>121</td>
<td>151</td>
<td>212</td>
<td>243</td>
<td>304</td>
<td>365</td>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*For Leap Year, this number will be 60 and add one to the rest. Total for Leap Year is 366.*

66
DISTRIBUTION LIST

1. Office of Naval Research
   800 N. Quincy Street
   Arlington, VA  22217-5000
   - Dr. Emanuel Fiadeiro (3)
   - Mr. William McCarthy (Code 00CCI)

2. Administrative Grants Officer
   Office of Naval Research Resident Representative
   101 Marietta Tower-Suite 2805
   101 Marietta Street
   Atlanta, GA  30303

3. Director, Naval Research Laboratory (Code 2627)
   Washington, DC  20375

4. Defense Technical Information Center (2)
   8725 John Kingman Road
   Suite 0944
   Fort Belvoir, VA  22060-6218

5. Naval Oceanographic Office
   Stennis Space Center, MS  39529
   - Mr. Landry Bemard
   - Dr. Martha Head
   - Mr. Joe Stinus

6. Technical Director
   Commander Naval Meteorology and Oceanography Command
   Stennis Space Center, MS  39529

7. Dr. Steve Payne (Code PMW 175-3B)
   Space and Naval Warfare Systems Command
   2451 Crystal Drive
   Arlington, VA  22245-5200

8. Director, Sponsored Programs Administration
   Mississippi State University
   PO Box 6156
   Mississippi State, MS  39762
USER'S MANUAL FOR THE RELOCATABLE MODELING ENVIRONMENT (RME) VERSION 1.0

Shuvobroto Brahmachari

MISSISSIPPI STATE UNIVERSITY
CENTER FOR AIR SEA TECHNOLOGY
STENNIS SPACE CENTER, MS 39529-6000

CAST TECHNICAL REPORT 5-98

RESEARCH PERFORMED UNDER OFFICE OF NAVAL RESEARCH GRANT NO. N00014-95-1-0203

APPROVED FOR PUBLIC RELEASE; DISTRIBUTION IS UNLIMITED

THIS TECHNICAL REPORT PROVIDES THE USER'S MANUAL FOR THE RELOCATABLE MODELING ENVIRONMENT (RME) FOR THE OFFICE OF NAVAL RESEARCH.